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Join the Hawkins Worldwide DNA Project!  
www.familytreedna.com/group-join.aspx?Group=Hawkins&Code=Z47192 

 

 
 
 
 
 
 
 
    

  
 
 
 
      http://www.geneticsand.us/ is an interesting site maintained by Nelda 
Percival (no, not genetic sand, read genetics and us). An excellent presentation 
of the types of DNA, and with pictures. Check it out. 
 
 
     If your Family Group does not have an Assistant Administrator, it is not 
being provided the assistance that is wanted. It is just no longer possible for 
me to provide the attention to the individual family groups as I have tried to in the past. It is not necessary that 
the Group Administrator be a testing participant, just a keen interest in advancing the knowledge within their 
family group. The family Groups that we have identifed that do not have a leader are 03, 06, 09, 13, 15, 16, 18, 
19, 20, 21, and 22. Volunteers please!.  
 
 

     The following was extracted from an article by James M. Irvine in the Journal of Genetic Genealogy, 6(1), 2010   
http://www.jogg.info/62/files/Irvine.pdf 

  
NPE’s (non paternal event) 

  

      There are a number of reasons that a male’s surname may differ from that of his biological father, including  
1. illegitimacy, both in-wedlock, and out-of-wedlock, when a young boy is given the name of his mother or 

her husband. 
2. Formal adoptions or name changes (since the 1850’s) ( and earlier in some countries by a husband or 

widower, so that he could inherit land from his wife or father-in-law).  
3. Unrecorded adoptions or name change. 

a. An orphan was given the surname of his guardian (e. g. a neighboring family). 
b. A young boy was given the surname of his widowed mother or his stepfather (especially pre 

19th century, and in Scotland where wives retained their maiden names). 
c. A migration, naturalization or administrative change led to the Anglicizing of a surname; 

4. Before surname became strictly hereditary (typically 12th-18th centuries). 

a. A boy took the patronymic of his father.  

b. A boy took his mother’s surname when she had higher status than his father (e.g. Oliver 
Cromwell);  

c. A man became known by his alias name (i.e. “aka”), such as his trade- or nick-name, or the name 
of the place from which he had migrated, or in which he now lived.  

 

     Considering all the above, we should not be terribly surprised if we were to find that we have a different 
surname from some where in our past. A large number of participants that find they match a different surname 
rather than their current surname, need remember that their NPE could have happened a very long time ago. 
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     From a DNA perspective of our Hawkins family history we view/classify NPE’s as either an 

 introgression (i-NPE), where a participant will bear the project surname, but bears the DNA signature 
of some other surname.  

 egression (e-NPE), where the participant will not bear the project surname, but will bear the DNA 
signature of one of the clusters (Groups) of the project surname. In practice e-NPE participants will 
probably have first joined another project that will have found them to be an i-NPE in that project.  

  

     Potentially then, one project’s e-NPE will be another project’s i-NPE, and vice-versa. 
 
 
Genealogy Gems: News from the Fort Wayne Library, No. 98, April 30, 2012 
 

Technology Tip of the Month--Using the Mask Tool in Adobe Photoshop by Kay Spears 
 
     Have you ever seen old photographs in a montage, or a photograph in which the person in the image seems 
to separate from the background, and wondered how that was done? Have you ever wanted to assemble a 
montage of your own family photographs? This article will describe one way to use the Adobe Photoshop Mask 
Tool for creating such visual effects. Adobe Photoshop Elements software older than version 9 does not have 
this tool. We will explore masking in older versions next month. 
 
     The Mask tool is one of my favorites in Adobe. I can get a multitude of amazing effects using it in 
combination with other tools in the program. Let’s pretend that I want to use a photograph of my grandmother 
in a family history, however, there are three other people in the picture. I want the focus of the photo to be my 
grandmother, so, I’ve decided to colorize her. There are a variety of ways to do this. I could just “paint” her, but 
I don’t like painting old photographs. I could also use my Erase tool, and erase everything around her. Instead, I 
am going to use the Mask tool in conjunction with the Layers tool. First, open up your photograph. Make sure 
that you have the Layers palette open. On the Layers palette, change the image from Background to Layer by 
right clicking and choosing “Layer from Background.” You will now see the word Layer on the palette. Next, 
right click on that layer and choose “Duplicate Layer.” There should now be two layers containing the same 
image. Select the top layer and colorize it by going to Image>Adjustments>Hue/Saturation and choosing 
“Colorize.” By adjusting the slide bars, you can make the top layer any color. I’m making mine blue. Click OK. 
 
     At this point, I have two layers – a blue one and the original black/white or sepia photograph. We are ready 
to apply the Mask tool. Make sure that the blue layer is selected. In the lower left hand corner on the Layers 
palette are some small icons. In my version of Photoshop Elements, the icon I want is third from the left, the 
“Add Layer Mask” icon. It looks like a rectangle with a circle in it. If you hold the cursor over it, a pop-up 
button appears saying “Add Layer Mask.” Click on this icon and look at the blue layer. A white box should be 
beside the image thumbnail. There are now two things on this one layer – the mask and the image. 
 
     The following step is very important. To make sure that the mask works, the color palette’s “Foreground 
Color” must be black. Access the color palette by clicking on the Tools bar. At the bottom of the Tools bar are 
two overlapping squares. To make sure that the top one is black, click on it. A Color Picker will open. Look at 
the values next to the letters R, G, and B. They should all say 0. In Adobe Photoshop, these three values are 
always 0 for black, and 250 for white. So, set all three to zero. Now, select the Brush Tool from the Tools bar 
and change its size and opacity settings as desired. Your cursor will change its shape accordingly. Return to the 
Layer Palette and on the top layer, click on the white rectangle associated with the mask. Now, not only is your 
cursor a Brush Tool, but your Mask is active. Go to the photographic image and apply your Brush to the areas 
you want to cover up or “mask.” You should start to see the bottom layer coming through. In my case, I am 
“masking” everything around my grandmother. When I’m finished, my grandmother will be the only object 
in the photograph that is colorized. 
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     You can create numerous effects with the mask by incorporating different layers of scenery, people or filter 
gallery effects. Be adventurous and experiment with the “masking” tool. Changing the Color Picker’s R, G, and 
B values back to white, or 250, and brushing over the area will return the image to its original state. You can 
also delete just the mask by dragging it to the Layers Palette Trash Bin. 
 
     Next article: Creating a Mask Using Adobe Photoshop Elements before Version 9. 

*** 
Genealogy Gems: News from the Fort Wayne Library No. 97, March 31, 2012 

Technology Tip of the Month--The Microsoft Word 2010 Ribbon: File Tab by Kay Spears 
 

     The File tab is the very first tab on the ribbon and contains several useful features. Under the Options 
feature, you will find most all of the settings for Word. Altering these settings will change the appearance and 
operation of Microsoft Word, so tread carefully. However, do take a look at the choices available. Some of the 
things you can change under Options are the spacing between words, the auto-correct features, spell checking, 
how documents print, etc. 
 
     Also located on the File tab is the Recent feature. This displays the last 20 Word documents and folders you 
have had open. Located to the right of each document or folder is a Thumbtack. Enabling this Thumbtack pins 
that particular document or folder to the top of the list. 
  
     The Save and Save As options are also located on the File tab. The Info tool will display basic information 
about the document that you have open, including who created it, when it was created, and what permissions 
may be attached to it. 
 
     The Print tool on the File tab features some interesting improvements. When you click on the Print button, a 
print view of your document is revealed on the right hand side of the screen. The number of pages in your 
document is shown at the bottom. At the top left of your preview document is the printer icon. Beside it, you 
may indicate the number of copies you want to make. The default printer connected to your computer is listed 
below the printer icon and a drop down arrow allows you to select an alternate printer, if one is available. The 
Settings appear below the listed Printer and may vary depending on your printer drivers and the capabilities of 
your printer. For instance, some printers have the capacity to duplex, or collate and staple, while others do not. 
Drop down arrows allow you to change the default settings. 
 
     For documents longer than one page, the printing options are Print All Pages, Print Selection, Print Current 
Page, or Print Custom Range. One of the features I like is the ability to select and print a single page from the 
preview document without flipping back and forth between File and Home. For instance, after clicking on  
File>Print, scroll to page three in the preview document and select Print Current Page, then Print. Only page 
three will print.                        So, let's say a fond farewell to the Ribbon. 
 
To subscribe to “Genealogy Gems,” simply use your browser to go to the website: www.GenealogyCenter.org. 
Scroll to the bottom, click on E-zine, and fill out the form. You will be notified with a confirmation email. 

 
 

--------------------***---***----------------- 
Input from our Hawkins Family Groups. The family pages are found at 

http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-1.html. 
 
Hawkins Family Group-04 (My, your editor’s, family group, phil_hawkins@sbcglobal.net.): Earliest known 
common ancestors are Jeffery and Dorothy (Mattock) Hawkins, emigrating from Wilts, England in 1682 to 
Bucks Co., PA. 
(http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-1.html#Group-04)  

 

http://www.genealogycenter.org/
http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-1.html
mailto:phil_hawkins@sbcglobal.net
http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-1.html#Group-04
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     This month I am including 
the pictures of the Hawkins in 

my direct line that I have pictures of. 
     The picture top left is my great-grandparents, Louisa 
(Turner) & Jonas Elwood Hawkins. To its right is a crop from 
an 1866 picture that included his mother Martha (Mills) 
Hawkins Cook. Jonas, 1857 - 1940 was born in Warren County 
Ohio, the only child of Charles Hawkins that died on Jonas’ 
first birthday. Charles was a son of Henry & Anna Pearson 
(Quakers), and grandson of Amos & Ann (Milhaus) Hawkins. 
Jonas inherited 160 acres of virgin land located in Tipton 
County Indiana that he started developing at age 18. He would 
eventually accumulate 900 acres of rich farmland in Liberty 
Township 
     Next are .my grandparents Edna (Spaulding) & Harry 
Talmage Hawkins, 1889 - 1950. The fourth of ten children he 
farmed 200 acres inherited from his and Edna’s parents. 
     My parents Lois (Pumphrey) & Harold Talmage Hawkins, 

1911 - 1996 with my grandson, and their first great-grandchild 
retired to Tipton County. Dad held a degree in Mechanical 
Engineering from 
Purdue University. 
He was the first in 
line to be granted a 
college degree.  
     My wife, Sharon 
(Wilcox), and I 
celebrated our 50th 
Anniversary in 
2003. We have two 
sons and two 
grandsons. My 
degree was in 
Business from 
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Butler University. I was a pilot and businessman. 
 
     The pictures Jonas, Harold, and myself are 50th 
Anniversary pictures. 
 
     Right are my sons Phillip M. (commercial pilot) & 
Stephen D (warehouseing). 
 
     Somewhere there should be pictures of Charles, 
Henry, & Amos and their families. I would dearly love 
copies. 
 
     I would like to run pictures for family group 
participants of those in your direct male line if you would like. Pictures with faces that are ¾” in size should be 
scanned at 300 dpi. If smaller, scan at 600. Do not send pictures with a resolution of 72 or 96 dpi unless they are 
very large. 
 
 
Hawkins Family Group-05 (Group Administrator is Jeanne Bornefeld, jeanne.bornefeld@yahoo.com.)  

(http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-1.html#Group-05)  
 
Lewis Hawkins, and the Weston Families. 
  

The Weston Cemetery. 
     This Cemetery is located in Fairmount Township Section #26, Range *E. T 23 N. The Jesse Holloway farm 
was the southwest 1/2 of the southwest 1/4 of Section # 26. In the 1990 Plat book there is still a G. Holloway 
on part of this land. But, at this time I am unable to determine exactly where the monument is. 
  

Fairmount News, 29 October 1932, p 4: 
     "Fairmount, Oct. 19. One hundred years ago, John Weston, one of the first settlers on Fairmount Township, 
built a cabin on what is now the Jesse Holloway farm, two miles east of this city, to which he brought his wife 
and children. One year later while walking in the woods near to cabin with a woman companion, Mrs. Weston 
saw what appeared to be a bright light in the sky. She interpreted this as an omen, foretelling her own death 
within a short time, and told her companion that she wanted to be buried on the top of a ridge, consisting of 
the only high ground in that vicinity, and even went so far as to designate the exact spot for her grave. In just a 
day to the year Mrs. Weston died, and was buried on the ridge on the eastern border of what is now known as 
the "Prairie", in a casket which consisted of a large log split with the center chopped out sufficiently to contain a 
body. A vault was constructed in the ground, to which the log casket was consigned and across the top of this 
vault, hand hewn clapboards were placed to provide the lid of the crude rough log. 
  
     Yesterday, W. J. Lewis, David G. Lewis, of this city, and J. A. Lewis, living east of town, went to the lonely 
grave on the Holloway farm, erecting a marker, suitably lettered, to the memory of their great aunt, who for 
many years has slept above what at one time was an arm of Lake Galatia, several miles northeast. All of the 
above historical facts came down to these men through family tradition, and the erection of the marker for Mrs. 
Weston, is a culmination of a plan which they had in mind for some time. The marker, constructed of cement, is 
a sturdy design and so erected that it is expected to remain in place indefinitely. It is said that nearby in after 
years, some six or seven other bodies of pioneers were interred near Mrs. Weston, but all trace of them have 
been lost in the intervening period." 
  
     The monument was erected 16 October 1932. Mrs. Nellie Weston was the wife of John Weston, and she was 
a sister to David Lewis, Jr. 

 

mailto:jeanne.bornefeld@yahoo.com
http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-1.html#Group-05
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     John Weston, b ca 1795 carter County, Tennessee, died 26 April 1845, Conway County, Arkansas. Eleanor 
Lewis, b 5 May 1797, Sullivan County, Tennessee, died 22 October 1836, Fairmount, Grant County, Indiana, 
buried Weston Cemetery. 
  
     Eleanor (Lewis) Weston was the daughter of David Lewis of Franklin County, Indiana. David was a brother 
to George Lewis, Jonathan Lewis, Mary Lewis (husband, John Barber) and Eleanor Lewis (husband, Moses 
Barber) Dearborne, County, Indiana. 
  
     The eldest child of John and Eleanor Weston was David Weston. David Weston was born 9 July 1820, 
Franklin or Hancock County, Indiana. He died 19 Dec 1875 Champoeg, Oregon. He married 27 January 1852 
St. Paul Oregon Territory, to Mary Sinclair, b Fall of 1842 at Ft. George (Astoria) Oregon Territory. She died 21 
Jan 1884 Champoeg, oregon. She was the daughter of Thomas Sinclair/St.Clair and Ellen Cullallcin. Ellen 
Cullallcin was the daughter of (Call-cino Che-wa-ca-pa) Chief Cowhicalas of the Chinook Tribe.  
  
     Nathan Hawkins and Ruth Cole were the parents of Mary Elizabeth Hawkins who married David Lewis, 
mentioned above. Mary Elizabeth and David Lewis left Sullivan County, Tennessee through the Cumberland 
Gap and came to Franklin County, Indiana. They entered land on the Big Salt Creek in Franklin County. David 
Lewis and family, his brother George and his family, with their two sisters and their husbands - Jonathan Webb 
and Moses Barber - left Sullivan Co., and on their way, stayed at their Uncle John Crockett's cabin. The next 
day, John, Davy's brother, took them a days trail toward Indiana. David Lewis, Jr. was a son of Mary Elizabeth 
Hawkins and David Lewis.  
 
Hawkins Family Group-07 (Group Administrator is Sara Hawkins Powell, sara-powell@sbcglobal.net .) The 
Group-07  family pages at http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-
1.html#Group-07  
 

Timeline for Nathaniel Macon Hawkins 
Created by Renate Sanders (gg-granddaughter) 

 
1831 - Nathaniel is born to parents Philemon and Jacobina (Sherrod) Hawkins in Louisburg, Franklin County, 
NC. 
 
1840 - Age 9 - At home with parents in Franklin County. 
 
1850 - Age 20 - Nathaniel lives at home with his parents and 6 siblings; Arch (22), Madison (21), Lucy (19), 
Fanny (17), Mary (12), Benjamin (10). Nathaniel’s father, Philemon, is enumerated as “Hotel Keeper”. Nathaniel 
is a “farmer”. (None of his siblins are noted to have jobs, which is interesting. Also, I wonder where the farm 
was?)  
Others listed are most likely boarding in the hotel, and at least some of them appear to work there. They are: 
Sidney Jeffries (Clerk), Samuel Perry (physician), Edward Lawrence (Surgeon Dentist), Ianu?z Wynn (17), 
Edward Ratley (table servant) 
 
1860 - Nathaniel lives in Louisburg with his mother (widowed) and 3 siblings, Fanny, Mary, and Benjamin. His 
occupation is “Negro Trader”. His mother, Jacobine, is now the hotel keeper. Nathaniel owns real estate valued at 
$625, but has a personal estate valued at $8140. Jacobine’s property is valued at $12,050, and personal estate at 
$4000. 
Nathaniel’s brother, Madison (a farmer), and his wife, Truxilla, live right next door. 
 
Slave schedule shows Nathaniel as owning only one slave - a 15 year old female. (This is almost certainly, Anna 
Green, who will become the mother of Nathaniel’s children.) The slave is enumerated in Franklinton, and 

 

mailto:sara-powell@sbcglobal.net
http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-1.html#Group-07
http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-1.html#Group-07
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appears to reside on some type of property with slaves of other owners. (Perhaps a work-farm of some type?) 
 
1864 - John Wesley Green is born to Anna. 

1865 - Emancipation of Slaves 
 
1868 - Elizabeth “Bettie” Green is born to Anna. 
 
1870 - Nathaniel (enumerated as “Nat”), remains single, and lives alone, in a neighborhood surrounded by 
blacks. (Anna and the children are listed in a different household, several pages away.) His occupation is now 
listed as, “trader”. His real estate is now valued at $4850, and his personal estate at $1200. (Family lore says that 
Nathaniel “put Anna and the children up” in a nice two-story home, which his family kicked her out of after his 
death, so perhaps that house is a part of that real estate which is being accounted for here.) 
 
1871 - Annie B Green is born to Anna. 
 
1873 - William Adam Green is born to Anna. *Confusion - Nov. 5, 1873 Bastardy bond implicates J J Murphy 
as the father of Anna’s child. Nathaniel signs the document (presumably as a witness). On the same date, in the 
exact same language and handwriting, another bond implies that Nathaniel has fathered a child with Alpharetta 
Dent, and is signed also by JJ Murphy. Alpharetta Dent and her children live on the same land as JJ Murphy, 
who is single, and all of her children are mulatto, just as Anna’s are. There’s some tom-foolery going on here! 
 
1876 - Mary Helen “Pidgy” Green is born to Anna 
 
1879 - Esther Green is born to Anna. (Family says that Esther may not have been Nathaniel’s, because she was 
darker-skinned, but until proven otherwise, I will count her as his.) 
 
Nathaniel dies. (Cause is not yet determined, but he was under doctor’s care.) 
 
-------------------------------------------------------------------------------------------------------------------------- 

Evidentiary documents related to Nathaniel Hawkins: (Copies in my possession) 
 
*Davis & Roads, January 4, 1865 - Promissary note to pay $585.00 for hire of negro man, Jess for the year. Signed 
by NM Hawkins, M. Hawkins, and PB Hawkins (Settled as part of estate on Oct. 28, 1881. Paid in full ($11.75) 
 
Nov. 1872 - Promissory note: Mr. Davis Spencer to Mr. Nat Hawkins for CJ Outlaw for carrying telegram at the 
death of Mr. Reid. 
 
*1873 - “I CJ Outlaw paid Nat Hawkins $2.00 in money. The said Nat Hawkins was on his way to Raleigh and 
promised to credit my note with the same on his return.” 
 
1879 - 1882 - Statement of account with O.L. Ellis, M.D: Shows Nathaniel’s care and prescriptions in July 1878, and 
Feb. 1879. Then shows 23 months interest and full payment of $9.65 by Nathaniel’s estate in 1882. (There are 
possible clues abt Nat’s cause of death. On 2/24/1879, he was charged $5.00 for a consultation with Drs. 
Foster and Clifton. On that same date, he was billed $1.00 for “bleeding self”. (This is the same date as the 
charge for the burial suit, so my guess is that Nathaniel died that same day, perhaps right there in the doctor’s 
office. 
 
*Yarborough & Co. - Feb. 24, 1879 - Bill for burial suit ($23.50) - See below. 
 
* Letter of Administration - Franklin County Probate Court, March 29, 1879: This document states that 
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Nathaniel died intestate, and names Phil B. Hawkins as administrator of his estate. (This is Nathaniel’s cousin, 
Philemon, who married N’s sister, Fanny.) 
 
*Franklin County Superior Court (no date/year given) - PB Hawkins, admin of NM Hawkins against PB 
Hawkins and wife, Fanny Hawkins, Mary M Hawkins, BF Hawkins, Madison Hawkins and others, and BF 
Hawkins guardian ad litem for the infant defendants, Henry M. Hawkins, Nathaniel Williams, Hawkins 
Williams, and Mary G. Willaims. (This an answer to a complaint, apparently in an ongoing court case to settle 
Nathaniel’s estate. As yet, I’ve not located the original complaint.) 
 
*Receipt for payment to Yarborough & Co. from estate of NM Hawkins (for burial suit) - Sept 22, 1889. 
 
Undated: Received of PB Hawkins, admin for NM Hawkins, $5.00 in payment offer for appearing as attorney 
for the guardian ad litem for the infant Cris(?) Outlaw (?) in a proceeding to (??) real estate assets. BB 
Massenburg 
 
Source info for this article was obtained by this researcher, Renate Y Sanders, using information from the 1840, 
1850, 1860, and 1870 Censuses on Ancestry.com, and during visits to the following: 

 North Carolina State Archives 109 E. Jones St. Raleigh, N.C. 27601 
 Franklin County Register of Deeds 113 S. Main St. Louisburg, NC 27549 

  
 
 
 

Hawkins Family Group-11 (Group Administrator is Susan Hawkins Warnock, swarnock@gmail.com. 
(http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-1.html#Group-11.)  
 
     Our “Brick Wall” = Who are the parents of John Daniel Hawkins, 1822 - 1875? 
 

Descendants of John Daniels Hawkins 
Generation 1 

1. John Daniels Hawkins-1 was born in 1822 in Marshall County, Tennessee. He died on 10 Sep 1875 
in Marshall County, Tennessee. 
Nancy Hutchins Bills daughter of Daniel Gersham Bills and Rachel Summers was born in 1818 in 
Tennessee. She died before 22 Jul 1897 in Alabama. 
John Daniels Hawkins and Nancy Hutchins Bills were married on 16 Sep 1845 in Marshall County, 
TN; by Wilson P. Davis, J.P.[1]. They had the following children: 
   i. 2. William Daniel Hawkins was born on 01 Jul 1846 in Marshall County, Tennessee. He 
married Laura Bell Enochs on 03 Jul 1887 in Lincoln County, Tennessee. He died on 13 
Sep 1907 in Tennessee. 
   ii. 3. James Amos Hawkins was born on 09 Jan 1848 in Marshall County, Tennessee. He 
married Martha Elizabeth "Matt" McAdams on 29 Oct 1868 in Marshall County, 
Tennessee[2]. He died on 19 Oct 1922 in Marshall County, Tennessee. 
   iii. 4. Leroy Cratus Hawkins was born on 12 Apr 1850 in Tennessee. He married Eliza E. 
Gilbert on 02 Aug 1885 in Marshall County, Tennessee[3]. He died on 06 Aug 1917 in 
Marshall County, Tennessee. 
   iv. 5. Mary E. Hawkins was born on 17 Sep 1852 in Tennessee. She married Robert A. Adams 
on 07 Dec 1876 in Marshall County, Tennessee[4]. She died on 04 Jul 1928. 
   v. Sara E. Hawkins was born in 1855 in Tennessee. She married Wilson B. Cochran on 19 
Jan 1871 in Marshall County, Tennessee[4]. 

 

mailto:swarnock@gmail.com
http://freepages.genealogy.rootsweb.ancestry.com/~hawkinsdnaproject/tree_g-1.html#Group-11
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   vi. 6. Caldora Hawkins was born in Jun 1856 in Tennessee. She died in 1932 in Marshall 
County, Tennessee. 
   vii. 7. John Thomas Hawkins was born on 11 Jun 1859 in Lewisburg, Marshall County, 
Tennessee. He married Annie Catherine McAdams on 20 Nov 1884 in Marshall County, 
Tennessee[2]. He died on 24 Feb 1935 in Ardmore, Carter County, Oklahoma. 
   viii. 8. Ewell Lee Hawkins was born on 09 Apr 1863 in Marshall County, Tennessee[5]. He 
married Mary Lu McAdams on 24 Dec 1885 in Marshall County, Tennessee[2]. He died on 
10 Jan 1936 in Petersburg, Marshall County, Tennessee[6]. 
  

Generation 2 
2. William Daniel Hawkins-2 (John Daniels-1) was born on 01 Jul 1846 in Marshall County, 
Tennessee. He died on 13 Sep 1907 in Tennessee. 
Laura Bell Enochs daughter of Robert R. Enochs and Martha E. Smith was born on 07 Jul 1855 in 
Tennessee. She died on 06 Aug 1907 in Tennessee. 
William Daniel Hawkins and Laura Bell Enochs were married on 03 Jul 1887 in Lincoln County, 
Tennessee. They had the following children: 
   i. Ida Abigal Hawkins was born on 06 Feb 1886 in Marshall County, Tennessee. She 
married Jesse Laurens Battle on 27 Sep 1910 in Pasco County, Florida[7]. She died on 05 
Oct 1953 in Wheaton, DuPage County, Illinois. 
Page 1 of 5 Friday, April 20, 2012 7:16:30 AM 
   ii. Roy D. Hawkins was born in Jan 1888 in Tennessee. He died on 02 May 1911 in Atlanta, 
Georgia[8]. 
   iii. James S. Hawkins was born in Dec 1890 in Tennessee. He died in Dec 1911. 
   iv. George Copeland Hawkins Sr. was born on 09 Apr 1892 in Flintville, Lincoln County, 
Tennessee. He married Ora Lee Damron on 19 Jun 1911 in Winchester, Franklin County, 
Tennessee[9]. He died on 25 May 1979 in Gadsden, Etowah County, Alabama. 
   v. Newton Jenkins Hawkins was born on 02 Nov 1896 in Flintville, Lincoln County, 
Tennessee. He married Gladys Pearl Moody on 27 Feb 1916 in Lake County, Florida. He 
died on 30 Jan 1983 in Fort Myers, Lee County, Florida. 
   vi. William Hawkins was born on 02 Dec 1884 in Tennessee. He died on 25 Jan 1890 in 
Tennessee. 
Mary Elizabeth Ewing daughter of Leander Newton Ewing and Jane M. Welch was born on 12 Feb 
1845 in Marshall County, Tennessee. She died on 20 Apr 1876 in Marshall County, Tennessee. 
William Daniel Hawkins and Mary Elizabeth Ewing were married on 20 Dec 1868 in Marshall County, 
Tennessee[2]. They had the following children: 
  i. Blanche Hawkins was born on 29 Nov 1869 in Tennessee. She married G. T. Mashaw on 
25 Dec 1890 in Marshall County, Tennessee. She died before Feb 1936. 
  ii. Mollie Hawkins was born about 1874 in Tennessee. She married John David Watson on 
03 Mar 1912 in Marshall County, Tennessee[9]. She died on 03 Feb 1936 in Marshall 
County, Tennessee. 
  
3. James Amos Hawkins-2 (John Daniels-1) was born on 09 Jan 1848 in Marshall County, Tennessee. 
He died on 19 Oct 1922 in Marshall County, Tennessee. 
Martha Elizabeth "Matt" McAdams daughter of Billie Mcadams and Lavina Mclean was born on 17 
Mar 1850 in Marshall County, Tennessee. She died on 15 Feb 1931 in Marshall County, Tennessee. 
James Amos Hawkins and Martha Elizabeth "Matt" McAdams were married on 29 Oct 1868 in 
Marshall County, Tennessee[2]. They had the following children: 
   i. W. Ozro Hawkins was born on 12 Apr 1870 in Tennessee. He married Mary Oliver on 18 
Jan 1891 in Marshall County, Tennessee. He died on 04 Aug 1892 in Tennessee. 
   ii. Myrtle B. Hawkins was born on 22 Jan 1874 in Marshall County,Tennessee. She married 
John Thomas. Ray about 1894[10]. She died on 20 Jun 1942 in Marshall County, 
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Tennessee. 
   iii. Lula May Hawkins was born in May 1878 in Tennessee. 
   iv. Claude Eugene Hawkins was born on 10 Sep 1879 in Tennessee. He married Emma L. 
Unk about 1911. He died on 10 Aug 1958 in Los Angeles County, California. 
   v. Leila Hawkins was born in Mar 1882 in Tennessee. 
   vi. Lena Hawkins was born in Mar 1882 in Tennessee. 
   vii. Lois Hawkins was born on 07 Mar 1884 in Tennessee[11]. 
   viii. Rachel Hawkins was born on 19 Apr 1886 in Marshall County, Tennessee. She married 
James Edward McCoy on 08 Aug 1902 in Tennessee. She died on 12 Jun 1954 in 
Lewisburg, Marshall County, Tennessee. 
   ix. Sammie Clarence Hawkins was born on 05 Jul 1887 in Marshall County, Tennessee. He 
died on 05 Jul 1954 in Marshall County, Tennessee. 
   x. T.H. Hawkins was born on 19 Feb 1891 in Tennessee. He died on 02 Oct 1892 in 
Tennessee. 
  
4. Leroy Cratus Hawkins-2 (John Daniels-1) was born on 12 Apr 1850 in Tennessee. He died on 06 
Aug 1917 in Marshall County, Tennessee. 
Eliza E. Gilbert daughter of John Gilbert and Margaret Ann Adams was born about 1846 in 
Tennessee. 
Leroy Cratus Hawkins and Eliza E. Gilbert were married on 02 Aug 1885 in Marshall County, 
Tennessee[3]. They had the following children: 
   i. O. L. Hawkins was born in Jun 1878. She died on 19 Feb 1901. 
Ollie M. Bills daughter of John Ashbury Bills and Tennessee C. Foster was born about 1859 in 
Tennessee. 
Leroy Cratus Hawkins and Ollie M. Bills were married on 03 Sep 1874 in Marshall County, 
Tennessee[2]. They had no children. 
  
5. Mary E. Hawkins-2 (John Daniels-1) was born on 17 Sep 1852 in Tennessee. She died on 04 Jul 
1928. 
Robert A. Adams son of Robert A. Adams and Julia Ann Darnell was born on 07 Oct 1852 in 
Marshall County, Tennessee. He died on 28 Mar 1924 in Marshall County, Tennessee. 
Robert A. Adams and Mary E. Hawkins were married on 07 Dec 1876 in Marshall County, 
Tennessee[4]. They had the following children: 
   i. Eula Adams was born in Sep 1877 in Tennessee. She married Thomas Collins on 13 Nov 
1894 in Marshall County, Tennessee[4]. 
   ii. Julia B. Adams was born in Oct 1879 in Tennessee. 
   iii. Nancy Adams was born in 1881 in Tennessee. 
   iv. Clarence Clifford Adams was born on 01 May 1896 in Lewisburg, Marshall County, 
Tennessee. He married Grace Alma Devin on 12 Oct 1916 in Marshall County, Tennessee. 
He died on 07 Oct 1937. 
  
6. Caldora Hawkins-2 (John Daniels-1) was born in Jun 1856 in Tennessee. She died in 1932 in 
Marshall County, Tennessee. 
Lorenzo Dow Turner[12] was born in 1856 in Tennessee. He died in 1936 in Marshall County, 
Tennessee. 
Lorenzo Dow Turner and Caldora Hawkins married. They had the following children: 
   i. William F. Turner was born in Mar 1883 in Tennessee. He married Olga Fowler on 18 Sep 
1910 in Marshall County, Tennessee. 
   ii. Maudie L. Turner was born on 06 May 1884 in Tennessee. She married Paul Wilson 
Fowler on 10 Jul 1917 in Marshall County, Tennessee. She died on 19 Apr 1960. 
   iii. Nancy Eliza Turner was born on 11 Aug 1886 in Marshall County, Tennessee. She 
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married Ward Thomas Fowler on 12 Jul 1919 in Marshall County, Tennessee. She died on 
02 Dec 1920 in Marshall County, Tennessee. 
   iv. Lillie M. Turner was born in Jan 1889 in Tennessee. 
   v. Kenneth Roy Turner was born in Oct 1892 in Tennessee. 
  
7. John Thomas Hawkins-2 (John Daniels-1) was born on 11 Jun 1859 in Lewisburg, Marshall County, 
Tennessee. He died on 24 Feb 1935 in Ardmore, Carter County, Oklahoma. 
Annie Catherine McAdams daughter of John Brysen McAdams and Caroline Unk was born on 26 
Apr 1861 in Lewisburg, Marshall County, Tennessee. She died on 23 Sep 1927 in Ardmore, Carter 
County, Oklahoma. 
John Thomas Hawkins and Annie Catherine McAdams were married on 20 Nov 1884 in Marshall 
County, Tennessee[2]. They had the following children: 
   i. Lessie Nell Hawkins was born on 01 Nov 1883 in Marshall County, Tennessee. She died 
on 04 Dec 1949 in Modesto, Stanislaus County, California. 
   ii. Susie W. Hawkins was born in Nov 1885. 
   iii. John Carson Hawkins was born on 18 Jun 1889 in Oklahoma (Lebanon, Indian Territory). 
He married Myrtle Nall on 17 Sep 1910 in Carter County, Oklahoma. He died on 26 Mar 
1973 in Beumont, Jefferson County, Texas. 
   iv. Sam Clifford Hawkins was born on 13 Jun 1891 in Tennessee. He married Lydia Pearl 
White on 12 Dec 1912. He died in Jul 1971 in Ardmore, Carter County, Oklahoma. 
   v. Clara Jane Hawkins was born in Jun 1892. She died in Feb 1955. 
   vi. James Shepard Hawkins was born in Jan 1894. He died on 26 Oct 1910. 
   vii. Bessie Pearl Hawkins was born in Dec 1897 in Indian Territory. She married Richard 
Blane Byrne about 1911. She died on 14 Mar 1978 in Oklahoma City, Oklahoma. 
   viii. Ettie Anna Hawkins was born on 06 Jan 1906 in Provence, Indian Territory, Oklahoma. 
She died on 04 Oct 1979 in Ardmore, Carter County, Oklahoma. 
   ix. Hettie Dean Hawkins. 
Georgia Owens daughter of Samuel Owens was born on 05 Feb 1880 in Camden, Arkansas. She 
died on 30 Oct 1963. 
John Thomas Hawkins and Georgia Owens married. They had no children. 
  
8. Ewell Lee Hawkins-2 (John Daniels-1) was born on 09 Apr 1863 in Marshall County, Tennessee[5]. 
He died on 10 Jan 1936 in Petersburg, Marshall County, Tennessee[6]. 
Mary Lu McAdams daughter of Joseph Henry McAdams and Mary L. Peyton[5] was born on 10 Feb 
1867 in Petersburg, Marshall County, Tennessee[11]. She died on 18 Jan 1940 in Petersburg, Marshall 
County, Tennessee. 
Ewell Lee Hawkins and Mary Lu McAdams were married on 24 Dec 1885 in Marshall County, 
Tennessee[2]. They had the following children: 
   i. John Thomas Hawkins was born on 29 Sep 1887 in Tennessee. He married Modena 
Kate Tate about 1910. He died on 19 Apr 1973 in Petersburg, Lincoln County, Tennessee. 
  

-- Sources -- 
 1   Marshall County Court Clerk, Tenn State, Marriages Jan 1838 thru Nov 1849, 93. John Hawkins to 
      Nancy H. Bills Md 16th September 1845 "solimnized the Rites of Matrimony between the Within 
      Named parties 16th September1845 Wilson P. Davis J.P.". 
 2    Marshall County Court Clerk, Tenn State, Marriages Jan 1838 thru Nov 1849.  
 3    Marshall County Marriages.  
 4    Tennessee State Marriages, 1765-2002.  
 5    Cemetery Records of Marshall County Tennessee by Marsh & Whitsell, 166.  
 6    Marshall County Tennessee Death Certificate.  
 7   "Florida Marriages" at familysearch.org.  



 
 
 

12 

Phil Hawkins - 2010 

 

 8   Lewisburg Tribune, Atlanta Constitution, and Family Bible.  
 9   Marriage License & Family Bible.  
10   1900 Census of Marshall County Tennessee, Census shows Myrtle and John Ray had been 
     married 6 years at the time of the census in June 1900. 
11 Tennessee Deaths and Burials, 1874-1955, FamilySearch.org.  
12 Thomas Ross Turner's family tree, Marshall Co. Gen Soc. books.  
  
 
 
 
 

 
 
 
 

*** *** *** 
     If you maintain a web site with Hawkins information, please add a link to our Hawkins DNA Project. If you maintain a 
website that relates to any of our Hawkins DNA lines, please advise, and I’ll list a link for it on our site. 
***     If you know someone that would like to be on the Hawkins project information mailing list, please send me their 
name and email and I’ll add them. Anyone that desires not to be on the list should request removal. 
***      Please advise us of any planned Hawkins reunions. We would like to list them indicating the patriarch, place, dates, 
and any other special information. Consider collecting donations to have some of the cousins in your group tested. Maybe 
you have the perfect paper records, but the mutations that occur in the separate lines need to be identified now for 
succeeding generations (and just maybe, your paper records are not as solid as you assume). 
***     If you have tested with someone other than Family Tree DNA please contact me about also participating in our 
Hawkins Project.     
***Reprints: Permission to reprint articles from the Hawkins DNA Newsletter is granted unless specifically stated 
otherwise, provided the reprint is used for non-commercial, educational purposes; and the following notice appears at the 
end of the article: Previously published in the Hawkins DNA Newsletter2012-04_30Apr2012. 
 

Phillip A. Hawkins, Administrator, Hawkins Worldwide DNA Project [No compensation 
received] 
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